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No warranty registration is necessary to obtain warranty on ALFTECH products. Please save
your proof of purchase receipt. If you do not provide proof of the initial purchase date at the
time warranty service is requested, the manufacturing date of the product will be used to
determine the warranty period.
1.
ALFTECH will repair or replace free of charge, any part or parts of the Product that are defective, but subject to
the following conditions:
1.1
Transportation charges on equipment and/or parts submitted for repair or replacement under this
warranty must by borne by the P urchaser, Distributor, Re-seller and/or End user;
1.2
The warranty period begins on the date of purchase by the first retail consumer or commercial end user
and continues for the period of two (2) years from that date;
1.3
ALFTECH shall have the sole discretion whether to replace or repair the Product, and the replacement
Product shall be of equivalent or better specifications, relative to the defective product but need not be
identical.
2.
The warranty does not extend to repairs required because of:
2.2
Problems caused by parts or systems that do not form an integral part of the Products;
2.3
Equipment control, use, maintenance or installations that are not in accordance with instructions and
manuals provided by ALFTECH for the product;
2.4
the product is repaired, modified or altered, unless such repair, modification is authorized in writing by
ALFTECH; or
2.5
the product serial number is defaced or missing;
2.6
Normal use which has exhausted the life of the product.
3.
ALFTECH makes no warranty that the operation of its software products will be uninterrupted or absolutely
error-free, and no warranty that all defects in the software product within or without the scope of ALFTECH's
applicable product documentation will be corrected.
4.
This warranty does not extend to any Batteries if installed in the Product;
5.
This warranty does not extend to any equipment, installation, assembly or system for which the supplier or
installer thereof provides a separate warranty, in which event the End user have to exercise his right and claim
against such a supplier or installer in accordance with such a warranty;
6.
This warranty does not extent to the installation, setup and configuration of the Product, for which the supplier
and/or installer are liable in their respective capacities.
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Products and Corporate names appearing in this manual may or may not be registered trademarks or
copyrights of their respective companies, and are only used for identification or explanation and to the
owners' benefit, without intent to infringe.
•
Windows is a registered trademark of Microsoft Corporation;
•
IBM is a registered trademark of International Business Machines;
•
Adobe and Acrobat are registered trademarks of Adobe Systems Incorporated;
•
Corel is a copyright of Corel Corporation.
®
This product/publication includes images from CorelDRAW 9 which are protected by the copyright
laws of the U.S., Canada and elsewhere. Used under License.
Specifications and Information contained in this manual are furnished for information only,
and are subject to change at any time without notice, and should not be construed as a
commitment by ALFTECH. ALFTECH assumes no responsibility or liability for any errors or
inaccuracies that may appear in this manual, including the products and the software
described in it.
Copyright © 2004 Alf Electro-Technical Services CC. All rights reserved.
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SECTION 1
Introduction
Product Overview:

Digital Audio Programmable Player

DAPP–FM1 R2

the DAPP Hardware

Your DAPP Hardware is a general purpose Digital Audio Programmable
Player, which provides playback of recorded audio messages (or alarms)
when triggered by an "event". As such, "events" can be activated by
hardwired triggers, scheduled software timers and devices that are
connected and communicate via a RS-485 interface.
Fig. 1: DAPP-FM1 Hardware
The DAPP–FM1 (Frame Mount)
is easily programmable with the
accompanied
DAPP–CONSOLE
software, allowing full set-up,
programming and configuration
off-site. Programming the DAPP
Hardware is done by connecting
the DAPP Hardware with the PC
on which DAPP-CONSOLE
is
installed and operational.

DAPP–CONSOLE

GND
+24V

Your DAPP Hardware is connected to your PC's parallel port (a standard
printer port & cable is used). Once properly configured, the DAPP
hardware can be mounted permanently in an appropriate Frame Mount
enclosure on-site.
The DAPP-FM1 has 3 LED indicators:
1. POWER
2. READY
3. BUSY

&

the DAPP Software

The DAPP–FM1 Hardware is supplied with DAPP–CONSOLE, a Microsoft®
Windows based graphical user interface software, which uses any MP3 (MPEG
1 or 2, Layer 3 Audio) compatible files for playback. Audio files can be
prepared in any program that can generate a MP3 compatible file, and will be
compiled and downloaded to the DAPP Hardware for playback.
For each "event" a trigger is configured that has an audio file assigned to play
when an "event" triggers its playback. Programmable Audio file playback
triggers can be Externally Hardwired Triggers, Programmed Timed Events or
RS-485 triggered events.
The DAPP Hardware provides 8 MBytes of memory (as standard), which can
store at least 16 minutes of CD quality mono audio for playback, or 34 minutes
"high quality" mono voice playback.

– LED is ON if powered.
– LED is FLASHING if the system is operational, i.e. running
according to the downloaded schedule.
– LED is ON during playback.

The complete DAPP–CONSOLE Software Users Guide is provided in
Section 2 of this Manual.

Fig. 2: The DAPP–C ONSOLE software user interface

Configuring Triggers
DAPP–C ONSOLE allows you to easily create and configure triggers for audio
playback. Audio playback can be activated by hardwired triggers, scheduled
timers and RS-485 triggered events. These different types of triggers can all
be configured from the Trigger Details Dialog as shown in Fig. 3 below.
Fig. 3: The Trigger Details Dialog

HARDWARE FEATURES
•
•
•
•
•
•
•
•

16 minutes of near CD quality mono playback, or 34 minutes "high
quality" mono voice playback
Mono, balanced line out
16 hardware triggers
62 scheduled timer triggered events (optional)
62 RS-485 triggered events (optional)
Each Hardware trigger can be individually programmed to be active high
or low
Each trigger can be assigned a priority level
Programmable via standard PC parallel port

HARDWARE CONNECTIONS

HARDWARE INDICATORS

•
•
•
•

•
•

•

24V DC supply input
16 hardware triggers
RS-485 (optional)
Balanced audio line-out
PC Parallel port connection

•

Power LED
System operational LED
System busy playing LED

1
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Your DAPP Hardware can be programmed step-by-step as follows:
STEP 1:

STEP 2:

STEP 3:

TIPS:

Create a new DAPP Project file (*.psf). Once a Project file has
been created, you can always re-open the file to edit, modify
and configure the hardware again. Any additions or changes
made to your project while working within DAPP-CONSOLE is
automatically saved to the DAPP Project File.
Use the Trigger Setup Wizard, which allows you to follow a stepby-step procedure to create new hardware triggers, scheduled
(timed events) triggers, or configure RS-485 triggered playback.
During this process, you will be able to define relevant options,
as well as associate a unique audio file (in MP3 audio format)
with each individual trigger.
As soon as you are satisfied with the configuration and design of
your DAPP Project, you will be able to download the program to
your DAPP Hardware. Note that you can also create a DAPP
Project in the absence of a connected DAPP. As such you will not
be able to download and test your DAPP Project without first
connecting the DAPP Hardware to your PC. This flexibility allows
you to create various new DAPP Projects, with the intent of
programming the hardware at a future time.
To re-assign a Hardware or RS-485 trigger already created right-click on the trigger in the Trigger Details Dialog, and select
"Reassign Trigger" from the context menu. This opens a
Reassign Dialog which allows you to select from a list of
available triggers to re-assign the selected trigger.
The Trigger Details dialog allows you to change all details
related to the triggers and scheduled events you created.

Downloading your scheduled events to the DAPP Hardware
Fig. 4: The Compile & Download Dialog
When you are satisfied with the
configuration
of
your
DAPP
Project, you will be able to
download the program to your
DAPP Hardware.
The Compile and Download Dialog
shows the status and download
progress, and will report any
errors, as well as a mismatch in
the Timer and PC date/time. If a
date/time mismatch of more than
1 minute is found, an error
message will notify you, and allow
you to synchronize the DAPP
Hardware's date/time with the
date/time of your PC's BIOS.

Note that you can also create a DAPP Project in the absence of a
connected DAPP. As such you will not be able to download and test your
DAPP Project without first connecting the DAPP Hardware. This flexibility
allows you to create various new DAPP Projects, with the intent of
programming the hardware at a future time.
DAPP–CONSOLE also offers the detailed Users Manual in a HTML (Web
Browser Format) that explains all options with software and hardware
operations in detail. In DAPP–CONSOLE , select the Help Menu, and Help to
access the online help documentation.
&

The complete DAPP–CONSOLE Software Users Guide is provided in
Section 2 of this Manual.

Software and Hardware Installation
Required Hardware & Software
It is recommended that you install the DAPP–CONSOLE Software on an
IBM-compatible PC running Windows XP, Windows 2000, NT4 SP3+ or
98SE* at a minimum screen resolution of 800×600 (Small Fonts).
As such, the minimum PC hardware required by Microsoft is:
q 133 MHz (or higher) Pentium or equivalent Processor;
q 64 MBytes of RAM recommended minimum;
q A 2 GByte Hard disk with at least 650 MBytes of free space;
q VGA or higher monitor;
q Keyboard;
q Mouse or compatible pointing device;
q A CD-ROM or DVD Drive.
*
DAPP–CONSOLE has been tested successfully on alternative Microsoft
Windows platforms, but ALFTECH makes no recommendation of the
use of such alternatives. Only LIMITED support is provided if the
DAPP Products are installed or connected to such alternatives.

Installing the DAPP–CONSOLE Software
Before installing DAPP–CONSOLE, please refer to the ReadMe.rtf text file
located on the installation CD-ROM for the most current updates &
information.
The installation requires about 10 MBytes of hard disk space.
1.
To launch the setup utility for your operating system, insert the CDROM into the CD drive.
2.
To start the installation click on the Start menu, click Run.
3.
Type x:\SETUP.EXE, where x: identifies the CD drive.
4.
Press Enter or click the OK Icon
®
The InstallShield dialog opens and will take you through the software
installation step-by-step. Minimal interaction is required.

Running DAPP–CONSOLE
Once successfully installed, DAPP–CONSOLE can be started by selecting the
Start Menu, click Programs, click on DAPP and finally click on DAPP–
CONSOLE . A short-cut Icon will also be placed on your PC's desktop, which
can be double-clicked to start DAPP–CONSOLE.

IMPORTANT:
Do not assume your PC's clock is accurate or correct.
Always verify that the time on your PC is in fact correct
before using the Synchronize Date/Time option.
Inaccuracy might have unintended consequences in
time critical/safety applications.
3
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Uninstalling the DAPP–CONSOLE Software
Before uninstalling the software package, ensure that the DAPP–CONSOLE
application is closed. Note that any files that are added to the "DAPP–
CONSOLE " installation directory after the initial software installation will not
be deleted by the uninstallation process. You will have to manually delete
these files after the uninstallation process has completed.
DAPP–CONSOLE can be removed by opening the Add/Remove Programs
applet in the Control Panel, i.e. select the Start Menu, click on Settings,
click Control Panel and finally select Add/Remove Programs. Select DAPP–
CONSOLE from the list of "Currently Installed Programs", and click on the
®
Change/Remove Icon. Follow the uninstallSHIELD directions to remove
all files as initially installed.

Connecting the DAPP–FM1 to your PC
To download the settings, configuration and audio files as created with
DAPP–CONSOLE requires that the DAPP Hardware must be connected to
your PC with a DB25Male to DB25Male Parallel Cable (pin-pin).
1.
Make sure that the DAPP Hardware is disconnected from its power
source.
2.
Plug the parallel cable into the desired parallel port at the back of
your PC, and plug the other end of the cable into the DAPP–FM1
hardware’s parallel port connector.
3.
Connect the DAPP Hardware’s power source, and make sure it is
switched ON. The power LED will glow bright green.
Please make sure that DAPP–CONSOLE is configured to communicate with
the correct LPT port to which the parallel cable is attached. To
automatically detect and set the correct port, open the Options Menu,
and select Ports. The "Detect Icon" can be selected to locate the
connected DAPP hardware.
&

The complete DAPP–CONSOLE Software Users Guide is provided in
Section 2 of this Manual.

Troubleshooting
DAPP–CONSOLE is unable to detect the connected
DAPP Hardware
Probable Cause:
1.

Make sure that the DAPP Hardware is powered, and the
power LED glows bright green.

ALSO:

Check the fuse on the DAPP Hardware to make sure it is
not blown. Replace with a "slow blow" 0.5 Amp fuse if
necessary. NOTE: This fuse will blow if the power supply
voltage exceeds the maximum recommended power
supply voltage.

2.

Make sure that the parallel cable is firmly plugged into the
parallel connecters on your PC, and on the DAPP
Hardware.

3.

DAPP–CONSOLE may have been incorrectly configured to
communicate with the DAPP Hardware using the wrong
parallel port.
5

FIX:

To correct this, open the Options Menu, and select Ports. If
you are unsure as to the correct port used, use the
"Detect Icon" to automatically search, detect and set the
correct port.

ALSO:

Be sure to set the Parallel Port to "SPP" (standard printer
port) in your PC's BIOS.

Other Issues:
1.

If you use a parallel cable longer than 1.8 meters
communications might become inconsistent due to signal
loss.

FIX:

Only use a high quality parallel cable, or make use of a
standard length 1.8 meter cable.

The DAPP – Hardware’s time is different to your
PC’s displayed time
Probable Cause:
1.
The time has not yet been synchronized. This has to be
performed manually (using DAPP–CONSOLE ).
FIX:
In DAPP–CONSOLE , open the Hardware Menu, and select
Status. Click on the "Synchronize Date/Time" Icon to set
the DAPP hardware’s time.
IMPORTANT: Do not assume your PC's clock is accurate or correct.
Always verify that the time on your PC is in fact correct
before
using
the
Synchronize
Date/Time
option.
Inaccuracy might have unintended consequences in
time critical/safety applications.
2.
The DAPP Hardware’s onboard battery might have failed.
NOTE: This failure will only reveal itself after you have
initially synchronized the Date/Time, and notice that
subsequently the displayed Date/Time differs.
FIX:
The hardware needs to be removed and a new battery
inserted (requires soldering). After replacing the battery,
connect the DAPP hardware to your PC and re-synchronize
the Date/Time.
DAPP–CONSOLE is unable to play a selected MP3
audio file in the "Sound File Setup" dialog
Probable Cause:
1.
Windows might not have a valid MP3 decoder installed, or
no Windows Media player is installed. DAPP-Console uses
the standard Windows Media Player to play the associated
MP3 file.
FIX:
Install a MP3 decoder, and/or install a Media Player for
Windows.
ALSO:
The audio file might not be a valid MP3 file. If this is true,
the "Sound File Setup" dialog will not display any
information associated with a MP3 file such as the Sample
or Bit Rates, etc.
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DAPP-FM1 Electrical Specifications

Detailed Pin Descriptions

Recommended Operating Conditions
(0° C to + 55 °C)

PARAMETER
Supply Voltage
Trigger Voltage

CONDITION

Absolute Maximum Ratings

MIN
22
0

TYP
24

MAX
26
24

NOTES
6
1,6

*

Voltage on V Supply, Relative to Ground
Voltage on Trigger pins, Relative to Ground
Operating Temperature
Storage Temperature
*

UNITS
V
V

0V
–60V
0 °C
5 °C

to
to
to
to

+34V
+60V
+70 °C
+55 °C

Exposure to absolute maximum rating conditions for extended periods of
time may affect reliability.

Electrical Characteristics
(Over the Operating Range)

PARAMETER

CONDITION

Supply Current

24V DC

MIN TYP
75

Power Consumption

22V to 26V

1.8

W

Trigger input Current

Trigger pulled to GND

3.5

mA

Trigger pull up
resistance

mA

6.8

LOW level Trigger
Voltage
30

Real Time Clock
Accuracy

0°C to +40°C

Battery Backup time
Audio Output Level
Output Resistance

V

Min/Yr

Power removed from
board

10

days

0 dBFS digital

+3

Hot or Cold to Gnd

22

dBu
W

22 Hz to 16 kHz

Signal-to-Noise Ratio

-3 dBFS digital

Total Harmonic
Distortion

-3 dBFS digital

± 1.5

10

24 volt Supply
Ground

Description
Description
Pin # COMPONENT SIDE Pin # COMPONENT SIDE
1

12

2

13

3

14

4

15

5
6

16
17

7

18

8

19

9

20

10

21

11

22

Output Hot
Output Cold
Output Ground

24 volt Supply
Ground

Physical Layout and Dimensions
Physical Connection
0.156 inch PCB Edge Connector

(Not Supplied)

A 22-way double-sided 0.156 in. (3.96 mm) pitch edge connector with solder
tag terminations and gold plated contacts is used in Frame Mount Applications.
Fig. 5: Schematic and dimensions of the 0.156 inch PCB Edge Connector

1

mS
±1

Frequency Response

Description
COMPONENT SIDE
Trigger Input 12
Trigger Input 13
Trigger Input 14
Trigger Input 15
Trigger Input 16
RS-485 Hot
RS-485 Cold
RS-485 Ground

kW
4

Minimum Trigger
pulse width

Memory data
retention time

MAX UNITS NOTES

Description
Pin # COMPONENT SIDE Pin #
A
N
Trigger Input 1
B
P
Trigger Input 2
C
R
Trigger Input 3
D
S
Trigger Input 4
E
T
Trigger Input 5
F
U
Trigger Input 6
H
V
Trigger Input 7
J
W
Trigger Input 8
K
X
Trigger Input 9
L
Y
Trigger Input 10
M
Z
Trigger Input 11

2

3

dB

4, 5

90

dB

4, 5

0.008

%

4, 5

Yr

Notes
1. The trigger inputs should be left flouting when not triggered, and must be pulled to GND
when triggered, with a relay contact or an open collector transistor.
2. The Real Time Clock may vary to ±4 Min/Yr over 0°C to +85°C.
3. The output level is between the hot and cold terminals. Peak to Peak voltage of 3.096 V,
RMS voltage of 1.095 V.
4. These parameters are not guaranteed.
5. Tested with 44100 Hz sample rate, 16 bits and 192 kbps data rate.
6. Power supply and all trigger inputs have reverse voltage protection.
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(all Dimensions in mm)

DAPP–FM1 Schematic
Fig. 6: Dimensions and Layout of the DAPP-FM1

SECTION 2
Introduction: DAPP–CONSOLE Software
DAPP–CONSOLE allows easy setup, configuration and programming of your
Digital Audio Programmable Player.
Fig. 7: Your primary software user interface (the DAPP–CONSOLE Desktop)
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Your DAPP Hardware can be programmed step-by-step as follows:
STEP •:
Create a new DAPP Project file (*.psf) by selecting the "New
Project…" Icon on the DAPP–CONSOLE Desktop (Fig. 7
above). Once a Project file has been created, you can
always re-open the file to edit and modify the configuration,
and re-configure the hardware again.
STEP ‚:
Use the Trigger Setup Wizard, which allows you to follow a
step-by-step procedure to create new hardware triggers,
scheduled (timed events) triggers, or configure RS-485
triggered playback. During this process, you will be able to
define relevant options, as well as associate a unique audio
file (in MP3 audio format) for each individual trigger.
STEP ƒ:
As soon as you are satisfied with the configuration and
design of your DAPP Project, you will be able to download
the program to your DAPP-FM1. Note that you can also
create a DAPP Project in the absence of a connected DAPP.
As such you will not be able to download and test your
DAPP Project without first connecting the DAPP Hardware to
your PC. This flexibility allows you to create various new
DAPP Projects, with the intent of programming the hardware
at a future time.
NOTE:
Any additions or changes made to your project while
working within DAPP-CONSOLE is automatically saved to
the DAPP Project File.

/ ( ' + DUGZ DUH
,QGLFDW
RUV
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Other Options & Features:
1.
2.

3.

4.

DAPP–CONSOLE provides options to select the PC Communications
port to which the DAPP Hardware is connected.
DAPP–CONSOLE provides a Hardware Status report, which detects the
installed DAPP Hardware and reports all relevant settings & the
system's status.
DAPP–CONSOLE provides a printable report which contains all details
of the Project as configured, as well as a list of all the configured
triggers, their exact details and the associated audio files.
This Software user's manual is available from the DAPP–CONSOLE
Help menu. Click on the Help menu in DAPP–CONSOLE , and select
Help. The user's manual will open in your default internet browser.

Compatible Hardware
DAPP–FM1
DAPP-Console is backward compatible, and supports all versions of the
DAPP-FM1 R1 and DAPP-FM1 R2 Hardware.

Creating new DAPP Projects
To create a new DAPP project, select "New" from the
"Project" menu, or click on the "New" Icon on the DAPP–
CONSOLE Desktop.
The FIRST STEP in creating a new DAPP Project consists of entering
more information into the Project Properties Summary Dialog.
Fig. 8: Project Properties Dialog

DAPP Memory Available
Open the drop-down list to select the default memory capacity of your
DAPP Hardware. This will pre-set the "DAPP Memory Available" to force
DAPP–CONSOLE to limit the amount of audio files that can be included in
the project. When the project is compiled, and you exceeded the
available memory, an ERROR message will notify you of this problem.
This allows you to return to the Trigger Details Dialog to reduce/change
the file sizes before attempting a download.
Auto Detect… Icon
Auto Detect will search the default port "as configured" to search for
the DAPP Hardware and detect the installed memory size.
Copy Audio Files to Project Folder?
This option will enable DAPP-CONSOLE to copy all associated Audio Files to
the default Project Folder. You can thus decide beforehand if you would
like to copy the audio files used and associated with each trigger to be
copied to the project directory on your PC’s hard disk.
Note that if you use large MP3 files a significant proportion of your hard
disk space will be used by these files - if you have decided to copy these
files to the project directory. On the other hand, if you decide NOT to
copy these files to the project directory and at a later time decide to
update/modify the project, some of these associated audio files might
have been removed, renamed or changed due to the needs of another
project. We would therefore recommend that you always enable this
option to maintain the integrity of each individual project.
The DEFAULT PROJECT FOLDER is the same folder that will be selected or
created as the location of your DAPP Project files (*.psf).

Save the new DAPP Project
The SECOND STEP allows you to save the new DAPP Project, using the
standard Windows "Save As…" Dialog:
Fig. 9: Windows Save As .. Dialog

Project Title, Subject, Author, Manager, Company, Category,
Keywords and Comments:
For your convenience the text details entered allow you to generate a
printable report, as a record of the current projects’ objectives.

Alternatively you can type a new or a different file name, and then select
the "Save" Icon to complete this process.
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You can also Browse to
a different folder or
network location
(Fig. 10), as well as
create a new folder
before you Save the
project (Fig. 11 below).

Fig. 10: Browse …

Hardware Trigger Events
Fig. 13: Hardware Trigger Event Set-up Dialog

Fig. 11: New Folder …

Create a New Trigger
DAPP–CONSOLE allows you to create three types
of triggers to activate audio playback: Externally
Hardwired Triggers, Programmed Timed Events
or RS-485 triggered events. Hardwired Triggers
activates audio playback by being hardwired to
the DAPP Hardware and playback is triggered by
an external event, which activates playback. The Scheduled Timers are
events that are activated at a specific time at specified day(s) during a
seven-day week for audio playback. The RS-485 triggered events
activates playback by an external event, which communicates with the
DAPP hardware via the RS-485 serial communications connection.
Fig. 12: Hardware Trigger Wizard Dialog

STEP 1:

STEP 2:
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Start by selecting a unique Hardware Trigger number by
opening the "Set Hardware Trigger #" dropdown list.

NOTE: a ">" at the end of items, for example: "Hardware
trigger: 1 >" indicates that Trigger number 1 has been
programmed and will appear as such in the Trigger Details
dialog. DAPP–CONSOLE allows the programming of up to 16
Hardwired triggers as found on the DAPP Hardware that
can be activated for audio playback.
Select the Hardware Trigger polarity as hardwired to the
DAPP Hardware. The hardware triggers are used to activate
playback from various inputs such as relays or switches.
The trigger inputs are normally high, and are pulled high by
the DAPP to +24 volts (continuous). When the input must
be triggered, the input must be pulled low, thus to ground.
With Polarity = NORMAL, a 0 volt potential will activate the
Hardware trigger, whereas with Polarity = INVERTED, a
continuous 0 volt potential is maintained with a voltage
potential of +24 volt activating the Hardware trigger.
Electrical Hardwired Specifications:
With Polarity = NORMAL,
Line = +24 v. continuous (or left open circuit),
Trigger Activation = pull-down to 0 v.
With Polarity = INVERTED
Line = pulled to 0 v. continuous,
Trigger Activation = rise to +24 v. cont. (or left open circuit)
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STEP 3:

STEP 4:

STEP 5:
STEP 6:

Select a PULSE or LOOP Hardware trigger, i.e. a PULSE
signal activating audio playback, whereas a continuous ON
signal will result in continuous "loop'ed" playback until the
signal returns to OFF. With Input = PULSE, an activated
Hardware trigger will result in playback of the associated
audio file. Input = LOOP will result in continuous playback
as long as the Hardware trigger remains activated. If the
signal returns to NORMAL/INVERTED playback will stop.
Set the priority level, from 1 to 250, with Priority = 1 the
highest, i.e. a Priority = 1 event WILL OVERRIDE any
Priority set as greater than 1. Any two or more events of
the same Priority will be activated first-in-first-out.

NOTE: As a safety precaution DAPP–CONSOLE will not allow
you to continue without specifically setting the triggers’
PRIORITY.
You have the option to add a unique description, which will
appear in the printed Project Report file.
Selecting "NEXT >" will allow you to choose a unique audio
file to associate with this trigger.

Sound File Setup Dialog
Each Individual Trigger (Hardware, Scheduled Event, or RS-485) is
associated with an audio file to be played upon activation. Sound files are
selected in the Sound File Setup Dialog, which provides options for
browsing, selecting and playing compatible audio files.
Fig. 14: Sound File Setup Dialog

& Software is installed, as it uses your PC’s default Media Player for
playback/verification. Other relevant details such as the audio file size,
playback duration and Sample & Bit Rate settings are also shown.
Compression Quality
The table provided below display Compression Settings suggested for
mono MP3 compressed files. If your MP3 encoder software cannot
compress in mono, compress the audio file in stereo and double the
data rate to maintain the same audio quality.
Commonly Used Compression Settings (mono)
Sample
Rate (Hz)

Bit Rate
(kbit/s)

Approx. time
(for 8 MByte)

Near CD

44100

64

17:00 mm:ss

Voice Good

44100

40

28:00 mm:ss

Voice OK

22050

32

34:00 mm:ss

Voice Acceptable

22050

28

39:00 mm:ss

Voice Phone

22050

24

45:00 mm:ss

AUDIO Quality

Useful Tip: When you need to accommodate a lot of voice data, it
would be preferable to use the lower sample rate of 22050 Hz, and
with a low data rate, as you will obtain a better "audible quality"
compared to using a higher sample rate with the same data rate.

Compatible Audio Files
Audio files should comply with certain restrictions and optimizations to
allow for a successful implementation.
When preparing a new audio file, make allowance to leave a minimum of
300 ms (milliseconds) of "silence" at the beginning of the file. The MP3
file that the DAPP Hardware reads from the flash consists of "frames",
and vary between 20 to 70 ms. To allow the decoder chip to synchronize
with the data feed can take a short period of time. To prevent "audible
clicks", the output is muted for this period, approx 300 ms and thus the
first part of any audio file will never be audibly heard.
NOTE: If the MP3 file contains an ID3 tag at the end of the audio file, it
must be removed with your MP3 encoder software prior to use with the
DAPP. ID3 tags contain text information about the audio file, and
unfortunately the DAPP Hardware will generate an audible click at the end
of playback if an ID3 tag is present.
Compression Settings
Your DAPP Hardware can play almost any MPEG 1, layer 2 or 3
(MP3), and MPEG 2, layer 2 or 3 compatible audio files. A sample
rate of 32000 Hz is not supported at this time because of inherent
hardware limitations.

Select an audio file by browsing for the correct Hard-drive or Network
path, then browse for the correct folder and finally pick on a compatible
audio file to associate with this trigger. The associated audio file name
and full path is shown as reference, with the option to Playback the
selected file. This feature will only work if a functional PC Sound System
15
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The sample rate will mostly determine the quality of the playback
audio.
Sample Rate

Supported

1

48000

Yes

2

44100

Yes

3

32000

No

4

24000

Yes

5

22050

Yes

6

16000

No

Schedule Timer Events
Fig. 15: Schedule Timer Event Set-up Dialog

The data rate is the amount of bits per second used to record the
audio signal. The standard for near CD quality audio is 128 kbit/s at
a 44100 Hz sample rate. The available options are listed below.
Data Rates Supported (kbit/s)
32,40,48,56,64,80,96,112,128,160,192,224,246,320

Working with MP3 Files
GoldWave Shareware Version, an affordable and fully functional
Shareware MP3 player can be installed from the DAPP–CONSOLE Software
installation CD-ROM. For more information about buying GoldWave please
visit the GoldWave website: http://www.goldwave.com. ALFTECH does
not make any recommendations or endorsements of this product, but
have found it useful in preparing and converting audio files to MP3
format. GoldWave is a sound editor, player, recorder, and converter. It
can create sound files for CDs, websites, answering machines, or
Windows sounds. A full set of effects and editing features are included
for professional sound production. High quality audio CDs can be created
by using GoldWave in conjunction with CD Recorder software.
Before using GoldWave, make sure sound drivers have been installed and
configured with the Windows Device Manager. Be sure to download the
"LAME" MP3 encoder from Goldwave’s website as well, as this "plug-in"
provides the MP3 encoding facility.
GoldWave is a shareware program.
It is not free software.
However, after trying GoldWave, the modest registration fee should seem
very reasonable considering all of the great features. To register and
encourage further development, please see the website detailed above.
GoldWave Registration License ± (US$40, Can$55, UK£25)

STEP 1:

STEP 2:
STEP 3:

STEP 4:
STEP 5:
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Start by selecting a unique schedule number, followed by
the time to activate the event. NOTE: a ">" at the end of
items, e.g. "Timer: 1 >" indicates that Timer number 1 has
been programmed and will appear as such in the Trigger
Details dialog. Enter the start time, in HOUR:MINUTE e.g.
03:15 will imply 3:15 AM, whereas 15:15 will mean
3:15 PM. Any one of up to 62 Event Timers can be
scheduled to activate audio file playback.
Select a specific day, or multiple days at which time this
scheduled trigger should activate.
Set the priority level, from 1 to 250, with Priority = 1 the
highest, i.e. a Priority = 1 event WILL OVERRIDE any
Priority set as greater than 1. Any two or more events of
the same Priority will be activated first-in-first-out.
NOTE: As a safety precaution DAPP–CONSOLE will not allow
you to continue without specifically setting the triggers’
PRIORITY.
You can optionally add a unique description, which will
appear in the printed Project Report file.
Selecting "NEXT >" will allow you to choose a unique audio
file to associate with this trigger. Please refer to the "Sound
File Setup Dialog" section above for more details.
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RS-485 Triggered Events
Fig. 16: RS-485 Trigger Event Set-up Dialog

STEP 1:

STEP 2:

STEP 3:
STEP 4:

Start by selecting a trigger from the RS-485 Trigger
dropdown list. NOTE: a ">" at the end of items, e.g.
"RS-485 trigger: 1 >" indicates that trigger number 1 has been
programmed and will appear as such in the Trigger Details
dialog. Any one of up to 62 RS-485 triggers can be
assigned to activate audio file playback.
Set the priority level, from 1 to 250, with Priority = 1 the
highest, i.e. a Priority = 1 event WILL OVERRIDE any
Priority set as greater than 1. Any two or more events of
the same Priority will be activated first-in-first-out.
NOTE: As a safety precaution DAPP–CONSOLE will not allow
you to continue without specifically setting the triggers’
PRIORITY.
You can optionally add a unique description, which will
appear in the printed Project Report file.
Selecting "NEXT >" will allow you to choose a unique audio
file to associate with this trigger. Please refer to the "Sound
File Setup Dialog" section above for more details.

Trigger Details Dialog
The Trigger Details Tabbed Dialog provides a "List View" of all the
Hardware, Scheduled Triggers and RS-485 triggers currently created, as
well as allows you to create new triggers/events in this dialog without
resorting to the Trigger Set-up Wizard.
Fig. 17: Trigger Details Dialog – Hardware Triggers Tab

Fig. 18: Trigger Details Dialog –
Scheduled Triggers Tab

Fig. 19: Trigger Details Dialog –
RS-485 Triggers Tab

By using the options available in the "Hardware Triggers", "Scheduled
Triggers" or "RS-485 Triggers" Tabbed dialogs • you are able to quickly
configure new, or change existing triggers. Double-click within the grid,
next to the number of the targeted trigger that you would like to change
or create. NOTE: As a safety precaution DAPP–CONSOLE will not allow
you to continue without specifically setting the triggers’ PRIORITY.
Context Sensitive Menus‚
A mouse "right-click" within the grid next to the targeted trigger
number will display a context menu allowing you to Delete a
configured trigger, Enable a new trigger, Playback & re-assigning
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Hardware or RS-485 triggers. Additionally, this context menu
provides an option for immediate Playback of the associated file for
audible verification. NOTE: This Playback functionality is only
available once the DAPP Project has been Compiled and
Downloaded to the DAPP Hardware. As such, it makes use of the
connected DAPP Hardware's onboard sound processing functionality
to play the audio file associated with the selected trigger. By
implication, the DAPP hardware should also be connected to an
appropriate audio amplifier and speaker(s) to audibly verify
playback.
The "Browse …" Icon ƒ also allow you to select or change the associated
audio file with the specific trigger.
A Progress Bar „ display the amount and percentage of memory used.
NOTE: if a RED background is displayed within this Progress Bar, it warns
that you are exceeding the installed DAPP Hardware’s memory capacity.
The "New …" Icon … will open the Trigger Set-up Wizard Dialog, which
allows easy and step-by-step configuration of new triggers.

Compile and Download
When your project has been configured, it needs to be downloaded and
tested on your DAPP Hardware. The current Projects’ settings,
configuration & audio files will all be downloaded to the connected DAPP
Hardware.
Fig. 20: The Compile and Download Dialog

TIP:

A Successful download might be followed by a Warning
messages:
A message showing that the PC and the DAPP's internal
clocks differ with more that 1 minute, which might have
important implications in obtaining accurate (timely) results
from the DAPP schedule.

Synchronize Date/Time
Fig. 21: Warning Dialog: Date / Time difference message

When the timer date/time and PC date/time differs, you will need to
synchronize the systems. The Synchronize Date/Time option will
synchronize the DAPP Hardware's time with the time of your PC's
BIOS. This will ensure that the DAPP Hardware's onboard clock is
synchronized with your PC's current BIOS date/time.
IMPORTANT:
Do not assume your PC's clock is accurate or correct. Always verify
that the time on your PC is in fact correct before using the
Synchronize Date/Time option. Inaccuracy might have unintended
consequences in time critical/safety applications.

Hardware Interface Setup
The communications Port selected to
connect to the DAPP Hardware can be
accessed from the Options Menu, select
Ports.
Your DAPP Hardware is connected to your PC's parallel port (a standard
printer port & cable is used). Setting the correct port allows DAPP–
CONSOLE to communicate with the connected DAPP Hardware.
Fig. 22: Hardware Interface Setup Dialog

Upon download, the download progress • will be displayed, and the
status report window ‚ will show relevant progress messages. The Status
Report will provide visual/text details during this process, showing the
most important steps and their progress. You do not need to interact with
this process, unless and error has occurred, upon which an appropriate
message will be displayed.
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If you are not sure to which Port your Hardware is connected to, please
use the "Detect …" Icon, as DAPP–CONSOLE will interrogate the ports
installed on your PC to search for the connected DAPP Hardware. You can
thus use the "Detect …" option, or ensure that the DAPP Hardware is
correctly connected and powered. If this communications process fails, an
appropriate ERROR message will be generated.

Hardware Status

Project Report
A preview of a Printable Project
Report can be activated from the
Print Preview Icon as shown here.
Alternatively, selecting the "Print" Icon
, DAPP–CONSOLE will
automatically print the Project Report to your default printer.
Fig. 24: Project Report Print Preview

The Hardware Status can be
accessed from the Hardware
Menu, select Status.
DAPP–CONSOLE communicates with the connected DAPP Hardware to
retrieve the system status as stored on the DAPP Hardware. If the
hardware cannot be detected or a communications problem occurs an
appropriate message will appear. At such a time make sure that your
hardware is connected to the correct port on your PC, and that the DAPP
Hardware is powered.
Fig. 23: Status Dialog

The Project Report preview allows you to see the report before printing.
The Print Preview Dialog provides basic functionality for viewing multiple
pages as well as your printer settings and other relevant features.
All the details in the report are extracted from your comments in the
Project Summary Dialog, as well as the settings chosen, comments and
scheduled events as configured.

Product Support
Fault reports, technical questions and support requests can be e-mailed
to info@alftech.com. We would recommend that you use the "Copy
Report to Clipboard …" option •, and include/paste the DAPP Hardware
Status Report in your e-mail request. This will provide us with some
detail as to the exact hardware version and configuration that you are
experiencing problems with.
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